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This Is Spinal Tablet: A Better 
Tool for Teaching Neuroanatomy  
• Robyn Fizz

r. Rutledge Ellis-Behnke is a re- 
search scientist in MIT’s Depart-

ment of Brain and Cognitive Sciences. 
He and Prof. Gerald Schneider teach 
9.14, Neuroanatomy, a course that relies 
heavily on illustrations and handouts. 
Reproducing all of the course materials 
in color was prohibitively expensive, so 
in 1998 Ellis-Behnke began to explore 
the option of using tablet PCs in class 
and dispensing with paper. Over the 
next few years, he and his colleagues 
discovered that using tablets greatly in- 
creased the students’ ability to learn and 
retain information. There were other, 
unexpected benefi ts as well. Here’s a 
look at how tablets have transformed 
the learning environment of 9.14.

The Classroom Experience
Ellis-Behnke began by comparing 

over 60 different tablet models. After 
narrowing the fi eld to two models and 
testing them for a semester, he opted 
for a Hewlett-Packard (HP) tablet – it 
was sturdy, had good battery life, and 
was easy to maintain. The tablets are 
loaned to students through the MIT 
Libraries, which allows the instructors 
to stay focused on content.

PowerPoint slides and other hand- 
outs for 9.14 are posted to Stellar, MIT’s 
online course management system. This 
makes the course materials easy to main- 
tain and revise, and easy for students to 

D

access via the Web (like laptops, tablets 
have built-in wireless network cards). 
This setup doesn’t require a special 
classroom or a plug at every seat.

The instructors, also equipped with 
tablets, no longer use blackboards. As 
they lecture about a slide, they can an- 
notate it on their tablet: both the slide 
and annotations are projected onto a 
large screen. The students, viewing the 
same slide on their tablets, can take 
notes right on the display using a digi- 
tal pen, or type notes using a mobile 
keyboard. They tend to switch between 
the two, and use multiple colors to high- 
light different anatomical structures. 

Students can add keyword tags to 
each page and then do searches to fi nd 
material for review. This saves them a 
lot of time, especially compared to fl ip- 
ping through vast amounts of paper. 
Required reading has increased from 
1100 pages, pre-tablet, to 1500 pages, 
and slides have increased from 700 to 
1200. But students have not been over- 
whelmed by these increases because the 
tablets let them organize the material 
effectively and access it instantly. 

Through trial and error, Ellis-
Behnke and his colleagues found that 
you don’t want to give all the material 
to the students up front, or they be- 
come passive learners. They need to 
take notes during class in order to 
learn. Providing about 60 to 70 percent 
of the intended material on each slide 
makes students pay attention, take 
notes, and learn – without turning 
them into stenographers.
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 MIT Libraries Working       
  with Google on Scholar 

The MIT Libraries have collaborated 
with Google to give MIT faculty and 
students greater access to materials 
retrieved through Google Scholar 
searches. Google Scholar, launched in 
November 2004, is designed to locate 
scholarly literature – such as peer-
reviewed papers, theses, books, and 
preprints – on the Web. While some of 
these materials, such as those found in 
DSpace@MIT, are available for free, in 
most instances, users can’t gain access 
to the full text of publications without a 
subscription or other form of payment.

By collaborating in a test project 
with Google, the Libraries are able to 
provide the MIT community with ac- 
cess to most of the 20,000-plus journals 
and other serials to which the MIT 
Libraries subscribe. Google Scholar now 
automatically recognizes connections 
originating from the MIT campus and 
shows an “MIT Access” link to full-
text articles found in the electronic 

versions of these publications. If an 
electronic version isn’t available 
through Google Scholar, the Libraries 
may own a print version. In this in- 
stance, users should try searching 
the Libraries’ online catalog, Barton, 
or VERA: e-journals + databases.

In addition, by going to 
http://scholar.google.com/
scholar_preferences

MIT users can choose MIT as their 
preference (certifi cates required). This 
allows Google Scholar to identify the 
computer as part of the MIT commu-
nity, even from off campus.

Testing and Feedback 
Google Scholar is currently a beta 

service. As the MIT Libraries work 
with Google on improvements for the 
MIT community, your feedback is 
welcome. You can send comments to 
<webmaster@libraries.mit.edu>. For 
more information on “Making Google 
Scholar Work for You,” see 
http://libraries.mit.edu/help/
google-scholar/ ø
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SPINAL TABLET

continued from page 1

Changed Interactions
While Ellis-Behnke and his col-

leagues expected tablets to enhance 
teaching and learning because course 
material could be delivered in color, 
they were surprised to fi nd that tablets 
also introduced fundamental changes 
in behavior. There were more student 
interactions after class and in eating 
areas. Students were seen explaining 
points to other students, using their 
digital pens to circle the areas under 
discussion. Tablets became part of the 
dialog, which has not been the case 
with laptops. This may be due to the 
tablet’s small size, or perhaps because 
laptop covers, fl ipped open, act as a 
kind of barrier. Ellis-Behnke has ob- 
served the same increase in student-
to-student interaction in tablet-based 
classes in other cultures (he also teaches 
at a medical school in Hong Kong) and 
in other age groups (elementary school 
children). Tablets act as magnets to 
bring students together.

Since the teaching assistants (TAs) 
for 9.14 no longer need to spend the hour 
before class making photocopies, they 
are able to greet students as they come 

to class and spend more time with them. 
Students have reacted positively to this 
in-person time with TAs. Tablets have 
also boosted the effectiveness of online 
offi ce hours: instructors and students, 
while in different locations, can use 
the tablets for quick drawings to get 
their points across. 

Another surprise was that students 
used the tablets everywhere. Tablets 
appear to meet a critical threshold of 
convenience in terms of weight and 
size. With class materials available in 
this highly portable format, students 
study when they are ready to study, as 
opposed to studying where the ma- 
terials are. Instead of lugging around 
textbooks, or making a trip to the li- 
brary, they turn on their tablets when- 
ever they have spare time. That might 
include a 15-minute ride on the subway. 

Tablets have also given instructors 
more fl exibility. Being able to quickly 
access selected chapters from different 
textbooks lets them customize the way 
they teach the course.

Bottom-line Results
Ellis-Behnke has been measuring the 

results of using tablets in the classroom. 
The benefi ts to learning effi ciency are 
clear. Even with signifi cantly more class 
materials, the bottom 25 percent of the

class improved a full letter grade after 
the tablets were introduced. This cohort 
learned as much as the average student 
did before the tablets were used. These 
are objective fi ndings, since the neuro-
anatomy exams are based on short 
answers, which require students to dem- 
onstrate understanding of the material.

In terms of dollars, the cost of tab- 
lets offsets the cost of photocopying. 
Neither is inexpensive. A tablet costs 
about $2000. However, photocopying 
with only some color handouts costs 
$700 per student per class, and that 
does not include the cost of textbooks 
or the environmental costs of paper 
storage and recycling. In addition, the 
Libraries loan out each tablet to an 
average of eight students a year – for 
courses and special projects.

Use of tablets in the classroom has 
also proven successful for Prof. Julian 
Wheatley in teaching Mandarin, a picto- 
graphic language; similarly, Dr. Hai 
Ning has developed tablet-based soft- 
ware to facilitate peer review of design 
concepts in MIT mechanical engineer-
ing classes. To learn more about tablets 
in the paperless classroom, look for 
Ellis-Behnke’s seminar on the topic on 
the Crosstalk page at
http://web.mit.edu/acs/Crosstalk/ ø
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Offi ce 2004 for Mac OS X Has 
Great New Tools in Its Kit  
• Esther Yanow and Bronwen Heuer

icrosoft Offi ce Professional 2004 
is the latest version of the Offi ce 

productivity suite for the Macintosh  
(OS X). It includes Word, Excel, and 
PowerPoint, as well as Entourage and 
Virtual PC 7. IS&T supports the fi rst 
three programs, but does not support 
Entourage or Virtual PC.

Across the Suite
Offi ce 2004’s Toolbox – with its 

splashy red icon – gives you access to 
some useful suitewide features:
• The Compatibility Report identifi es 

and resolves issues that can occur 
when you share Word, Excel, or 
PowerPoint documents with users of 
other versions of Offi ce. This report 
displays a list of issues (for exam-
ple, font and image compatibility 
problems), and you can fi x, ignore, 
or get more help about them.

• The enhanced Scrapbook (formerly 
the Clipboard) lets you catalog your 
cuts and copies. You can look at items 
in List, Detail, or Large Preview 
views, assign them keywords, and 
search and display them by metadata 
details (e.g., creation date, category).

• The Reference Tool tab takes you to 
the Encarta dictionary, a thesaurus, 
and a link to Microsoft’s online 
Encarta encyclopedia. 
Offi ce’s Formatting Palette replicates 

– in one place – much of the functionality 
found in menus and buttons. You can 
move this palette around on the screen 
and expand and collapse its sections. 
“Add Objects” has been added to the 
palette in each of the programs. When 
you select a graphic object, the palette 
now offers a complete array of picture-
formatting tools. 

New Program-Specifi c Features
Each Offi ce 2004 program has new 

tools that can increase your productiv-
ity. Here are the highlights.

Word 2004:
• Notebook Layout View facilitates 

note taking on its lined “paper.” You 
can add tabs for new sections, de- 
mote or promote notes, and even 
attach audio recordings using your 
computer’s built-in microphone. 

S o f t w a r e  S p o t l i g h t  

M

You can also fl ag notes for follow-
up, sort, and do keyword searches 
to fi nd your place quickly.

• Track Changes now adds balloons, 
color-coded by reviewer, on the right-
hand side of the page. These bal- 
loons show comments and deletions.

• The Navigation Pane, under the View 
menu, adds a pane on the left-hand 
side of your fi le, where you can 
choose between a thumbnail view or 
a document map. This is especially 
useful for navigating long documents.   

    Excel 2004:
• You can now easily change the color 

scheme for charts using a drop-down 
list in the Formatting Palette. More 
advanced types of formatting con- 
trol include shades of colors, lines, 
fi lls, and the ability to make some 
elements transparent.

• The Page Layout View lets you see 
quickly how your document will 
look when printed. You can then 
scale your data to avoid awkward 
page breaks.

PowerPoint 2004: 
• Presenter Tools, under the View 

menu, divides your computer’s 
screen into panels that display your 
slides, thumbnails of the slides for 
quick selection, and speaker notes. 
Arrows let you move forward and 
backward, one slide at a time, and a 
clock helps you keep track of time. 
Connect your Macintosh to a pro- 
jector, and Presenter Tools lets you 

display just your slides to the audi- 
ence, while you can see the full dis- 
play, including speaker notes, on 
the computer. 

• PowerPoint 2004 offers many new 
animation effects and transitions, 
including 3D transitions that are 
exclusive to the Macintosh.  
To learn more about new features, 

see Mactopia’s Offi ce 2004 Highlights at
http://www.microsoft.com/mac/
default.aspx?pid=offi ce2004

System Requirements
To run Offi ce 2004 Professional at 

MIT, you need
• a G4 or greater that is Mac OS X 

compatible
• Mac OS X 10.3 or higher
• 256MB or more of RAM
• 450MB of disk space for a recom-

mended install; 630MB for a full 
drag-and-drop install

• a CD-ROM drive or network con- 
nection (depending on your instal- 
lation method)

How to Obtain
If your department, lab, or center is 

participating in the Microsoft Campus 
Agreement at MIT, you can obtain the 
media from your area’s software liai- 
son. For a list of software liaisons, go to 
http://web.mit.edu/ist/services/
software/msca-liaisons.html#2

Otherwise, you can buy Offi ce 2004 
online from GovConnection, taking 
advantage of MIT’s Select Agreement 
with Microsoft. For details, see  
http://web.mit.edu/ist/services/
software/msca.html 

Support
IS&T maintains a Microsoft Offi ce 

2004 Professional for Macintosh page at
http://itinfo.mit.edu/product.php?
vid=656&platform=Macintosh

IS&T also offers Quick Starts and 
hands-on courses in Word, Excel, and 
PowerPoint. For details, go to 
http://web.mit.edu/is/topics/
training/ 

and click on the Training Catalog and 
Registration link.

If you need help using Offi ce 2004, 
contact the Computing Help Desk at 253-
1101 or <computing-help@mit.edu>. ø 

The Compatibility Report resolves issues 
between different versions of Offi ce.
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This column presents announcements 
about IS&T-supported software. For 
more information about recent releases, 
see http://web.mit.edu/swrt/

N e t w o r k  N o t e s

Email Users: Make the Move 
from POP to IMAP
• Jon Hunt

nformation Services and Technology 
(IS&T) has been recommending In- 

ternet Message Access Protocol (IMAP) 
for accessing email for several years 
and is now promoting IMAP as MIT’s 
primary mail protocol. IMAP provides 
fl exibility and functionality that the 
Post Offi ce Protocol (POP) does not. 
All of MIT’s recommended email ap-
plications (clients) support IMAP and 
some, such as Outlook, only support 
IMAP.

IMAP resolves problems that can 
occur with email clients that use POP. 
One of the most common problems is 
receiving duplicate messages: this can 
happen because POP was never de- 
signed to handle email retrieval from 
multiple machines. A kludge enables 
this functionality in POP, but it does 
not always work, and users can end 
up with multiple copies of the same 
message. With IMAP, email is stored 
on the central servers, and you can 
securely and reliably access your email 
from multiple machines.

IMAP also has several useful fea-
tures that POP does not provide:
• You can access your email from any 

web browser using WebMail. 
• You get 250MB of space on enter-

prise email servers. 
• You can optimize your email client 

to handle large volumes of email 
over slow connections by down-
loading just the headers and then 
selecting messages to read. This is 
very useful for PDA email clients.

• You can access email from multiple 
machines with ease and maintain 
the messages status (such as read 
or unread) between them.

• You can easily confi gure and check 
MIT’s Spamscreen, since it shows 
up as a folder within your IMAP 
inbox.
Recommended Clients
IS&T supports the following IMAP 

email clients:
For Windows
–  Outlook 2003
–  Eudora 6.2.1 

For Mac OS X
–  Apple Mail 
–  Eudora 6.1 or later
For Linux and Athena
–  Evolution 1.4.5
For Palm-based PDA devices
–  SnapperMail Enterprise 2.1.1
–  VersaMail 2.7 and greater

To facilitate the 
migration from 
POP to IMAP, 
IS&T launched 
email client 
release efforts 

for Eudora 6.2.1 
and Apple Mail. 

The Eudora 6.2.1 installer will migrate 
current Eudora POP users to IMAP 
unless they opt out during the instal- 
lation. IS&T has also worked to ensure 
that the installer functions for Group 
Policy deployment in win.mit.edu.

To fi nd out more about any of the 
recommended email clients, go to the 
IS&T web site at 
http://web.mit.edu/ist/

and type the name of the software in 
the search box. 

Security Vulnerability in Eudora 
for Windows 
Note that the Windows versions of 

Eudora 5.2 and earlier have a vulner-
ability that, if exploited, would enable 
an attacker to execute arbitrary code 
remotely on a machine. In order to 
be secure, Windows users running 
Eudora 5.2 (or earlier versions) should 
either upgrade to Eudora 6.2.1 or mi- 
grate to another IMAP email client 
such as Outlook 2003. The details of 
this vulnerability will be made public 
on May 2, 2005 and an exploit is more 
likely once the details are published.

Support
IS&T is providing documentation 

and support to help users migrate from 
Eudora to Apple Mail or Outlook. You 
can fi nd the Guide to IMAP at MIT at
http://web.mit.edu/ist/topics/
email/imap.html

You will also fi nd some useful tips in 
the Tech Tips column on page 6.

If you have questions about migrat-
ing to IMAP, contact the Computing 
Help Desk at 253-1101 or <computing-
help@mit.edu>. ø 

IS&T Supports Adobe Reader 7.0 
Adobe Reader 7.0 is the latest version of 
the free software from Adobe Systems 
that lets you open, view, search, and 
print Portable Document Format (PDF) 
fi les. This fi le format, based on Post- 
Script, is highly portable across plat- 
forms and is often used to share fi les 
with others who don’t have the same 
software or fonts.

This new version of Adobe Reader 
provides faster launch times and real-
time zooming and panning. It also 
contains enhanced search features, 
a unifi ed selection tool, and greatly 
improved accessibility features. To 
learn more about Adobe Reader 7.0, 
go to 
http://www.adobe.com/products/
acrobat/readermain.html

You can download Adobe Reader 
from the Adobe web page above or by 
starting at the Adobe Reader at MIT 
page at
http://itinfo.mit.edu/product.php?
name=acroread

The MIT web page also has several 
related links with helpful information.

Note that Adobe recently released 
the Reader 7.0.1 update and recom-
mends that all users of Adobe Reader 
7.0 apply this update. For details and 
to download the update, go to
http://www.adobe.com/support/
downloads/main.html

If you need help installing or 
using Adobe Reader 7.0, contact the 
Computing Help Desk at 253-1101 or 
<computing-help@mit.edu>.

Discount Option for Adobe Software 
MIT is a member of the Massachusetts 
Higher Education Consortium. One 
benefi t is the option to purchase dis- 
counted licenses for Adobe products, 
for use on MIT-owned equipment, 
from TRC. For details on this (and 
other MIT software discounts), visit 
the Volume Site License page at
http://web.mit.edu/ist/products/vsls/

MIT’s contact at TRC is Tom Kolodziej. 
You can reach him at (800) 517-2320, 
x209 or <tom@gotrc.com>. ø
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Think Before You Send: 
Confi dential Data and Email
• Jeff Schiller

any members of the community 
work with information that 

should be kept private. In the course 
of doing their work, they may send 
confi dential data to others via email – 
without being aware of the risks in- 
volved. Here’s a quick look at those 
risks and how to minimize them. 

A Trio of Risks
Email is at risk of being compro-

mised when
• Stored on a personal computer.

• “In fl ight” from the sender to MIT 
post offi ce servers and from MIT 
post offi ce servers to the recipient.

• An MIT recipient chooses to receive 
email at an account outside of MIT. 
Outside email systems include 
“free” services such as Gmail from 
Google, Hotmail, and Yahoo! Mail.

The risk to information stored as an 
email message on a computer is no dif- 
ferent than the risk to any information 
stored on a computer. For tips on how 
to protect data on your computer, see
http://web.mit.edu/ist/topics/
security/infoprotect.html

The risk to e-mail “in fl ight” is 
limited because anyone wanting to in- 
tercept the data has to be listening at 
just the right time. In addition, modern 
email clients have the capability to en- 
crypt email as it is being transmitted.

However, when email is sent to an 
outside mail system, the sender loses 
control of it. There is no way of know- 
ing how email is protected on this sys- 
tem, nor how long it may be stored. 
Most systems keep copies of email even 
after you delete it from your mailbox. 
Privacy statements from outside email

M

systems make it clear that they cannot 
guarantee the confi dentiality of email.

When you send someone email, you 
have no control over where they will 
receive it. An email address that appears 
to be located at @mit.edu may in fact be 
forwarded off campus. You can, how- 
ever, control where you receive email.

Although MIT has no explicit guide- 
lines about where individuals choose to 
receive their mail, it does have a policy 
that people who handle sensitive data 
should take steps to guard that infor- 
mation. If you regularly receive sensi- 
tive information in your email, you may 
want to think twice before forwarding 
your mail to an off-campus email ad- 
dress. If you’re aware that a recipient 
to whom you are sending confi dential 
information routes their email to an 
off-campus provider, you might want 
to reconsider sending sensitive infor- 
mation to them via email.

Concerns?
If you have questions about hand- 

ling confi dential data in email, contact 
<security@mit.edu>. ø
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SAP Update and Hardware 
Renewal Slated for May
• Diana Hughes

S&T is planning an SAP hardware 
renewal from May 20 through May 

22. It will include the following. 
• Hewlett Packard (HP) Alpha ma-

chines will be replaced with Sun 
V490 and V890 machines.

• The operating system will move 
from HP tru64 to Sun Solaris 9.

• The SAP kernel, SAP application 
support packages, and SAP Oracle 
database will be updated.

• The SAP Internet Transaction Server 
support packages will be updated 
from version 14 to 17.
The hardware renewal is being done 

because the HP hardware is six years old. 
Parts availability and the lack of trained 
fi eld engineers have been ongoing issues. 
Renewing the hardware also minimizes 
the impact on the SAP module imple-

I

mentations planned by the HR-Payroll
and Environmental, Health and Safety 
projects for early 2006.

The Sun hardware will provide a 
stable SAP environment for the next 
several years and reduce the risk of 
hardware-related outages. It will also 
facilitate upgrading to the next SAP 
release, planned for 2006.

Putting IT to the Test 
In preparation for the hardware re- 

newal, integration testing will take place 
May 2 through May 13. The testing will 
focus on critical SAP business processes, 
as identifi ed by business units and the 
IS&T Administrative Computing Team. 
External interfaces to SAP – such as the 
MIT ID Database, IXOS, Roles Database, 

ECAT, Data Warehouse, and Athena 
Print Servers – will also be tested.

The Administrative Computing 
Quality Assurance (QA) Team will co- 
ordinate integration testing. Adminis- 
trative Computing Team members and 
business process owners will participate 
in testing exercises in the Development 
(SF2) and Education & Practice (SF6) en- 
vironments. Testing will be done manu- 
ally from written test scripts, and issues 
will be logged in the QA Test Issue 
Database. The QA Team will be respon- 
sible for resolution of all open issues.

Questions?
To contact the team working on 

these updates, send email to <sap-
spring-renewal@mit.edu>. ø

A d m i n i s t r a t i v e  A s p e c t s

Key Dates 

April 18–29:  SF2 (Development environment) unit testing
May 2–13:  SF6 (Education & Practice environment) integration testing
May 20–22:  PS1 (Production environment) application of updates
May 23:  Updated SAP Production available to MIT community
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The Network Notes column on page 4 
details the advantages of switching your 
email client from Post Offi ce Protocol 
(POP) to Internet Message Access Pro- 
tocol (IMAP). Making the switch will 
change some aspects of your email ex- 
perience; the tips that follow can help 
you make the transition.

How can I check my email 
quota?

All MIT account holders have 
250MB of storage on the mail 

servers. However, POP users rarely fi ll 
their quota, because they store their 
messages on their computers, rather 
than on the server. When you switch 
to IMAP, you’ll need to keep an eye 
on your quota. You can check it at
https://nic.mit.edu/postoffi ce/quota
(MIT certifi cate required)
Your quota is also displayed above the 
Inbox message listings in WebMail.

You can fi nd tips on how to manage 
your email quota at
http://web.mit.edu/ist/topics/
email/manage.html

How do I know which incoming 
mail server I’m on?

When you confi gure your IMAP 
mail client, you’ll need to specify 

your mail server. You can fi nd this 
information at 
http://web.mit.edu/ist/topics/
email/query.html

How does the move from POP 
to IMAP affect spam fi ltering?

If you use Eudora with POP and 
have opted for MIT’s spam fi lter- 

ing, you probably have a fi lter in place 
that moves any incoming spam mes- 
sages to a dedicated folder.

For IMAP users, IS&T recommends 
using a Spamscreen folder instead. If 
you have one, your spam messages will 
be delivered automatically to your 
Spamscreen folder on the mail server, 

This column presents tips about computing. 
If you have a question you would like to 
see answered here, send it via email to 
<techtips@mit.edu>.
For more information technology Q&As, 
check the IS&T Stock Answers database at
http://itinfo.mit.edu/answer/

http://web.mit.edu/ist/services/
email/nospam/index.html#settings

How does the migration to IMAP 
affect my backup scheme?

When you use POP, your email is 
stored locally on your computer, 

and so can be backed up using TSM or 
another method. With IMAP, your email 
is stored on the mail server, so your mes- 
sages won’t be included in your system 
backups. The mail servers are backed 
up nightly in case of server failure, but 
there is no service for restoring indivi- 
dual messages or mailboxes. You may 
want to back up important messages 
manually, in case you accidentally de- 
lete them. You can do this by saving 
a copy of the messages to a local mail 
folder, which can be included in your 
TSM or other backups.

Help! I switched from POP to 
IMAP, but no mail is arriving in 

my In mailbox in Eudora!

Don’t worry; this is normal. The 
In mailbox in Eudora is a local 

mailbox, with messages stored on your 
computer. When you switch to IMAP, 
your mail is delivered to a folder called 
Inbox on the mail server. To access that 
folder, go to the Window menu if you’re 
using a Macintosh, or the Tools menu 
on a Windows machine, and choose 
Mailboxes><<Dominant>>>Inbox 
(see screenshot).

Note: If you use personalities in 
Eudora, you may need to choose the 
personality name, rather than 
<<Dominant>>.

If you don’t fi nd your new messages 
in the Inbox on the server, contact the 
Computing Help Desk at 253-1101 or 
<computing-help@mit.edu>. ø

rather than to your Inbox. Here’s how 
to make the change:

First, you’ll need a Spamscreen 
folder. Spamscreen folders have been 
created automatically on all accounts 
set up after October 4, 2004. If you don’t 
already have a Spamscreen folder, you 
will need to create it. If you’re using 
Eudora with IMAP, follow these steps.

On a Windows machine:
1. Go to Tools>Mailboxes.
2. Click on the plus sign next to 

<<Dominant>> to expand the 
subfolders list.

3. Right-click on the Inbox and choose 
New…

4. Name the new mailbox Spamscreen. 
Be sure to capitalize the fi rst letter!
On a Macintosh:

1. Go to Window>Mailboxes.
2. Click on the arrow next to <<Domi-

nant>> to expand the subfolders 
list, and select the Inbox.

3. Click on the New Mailbox button, 
the second button from the left at the 
bottom of the Mailboxes window. 
This will create a subfolder called 
“Untitled Folder.”

4. Rename this folder Spamscreen. Be 
sure to capitalize the fi rst letter!
If you’re using a program other than 

Eudora, you can fi nd instructions on 
how to create your Spamscreen folder at
http://web.mit.edu/ist/services/
email/nospam/index.html#confi gure

Next, you’ll need to delete your old 
POP-style fi lter in Eudora.
1. Go to Tools>Filters on your Win- 

dows machine, or Window>Filters 
on your Macintosh.

2. In the left-hand pane of the Filters 
window, locate the fi lter X-Spam-
Flag:YES.

3. Select this fi lter, and click on the 
Remove button.

4. Close the Filters window, and save 
your changes when prompted.
Since the contents of the Spamscreen 

folder count towards your mail quota, 
be sure to empty it from time to time. 
An auto-purging option is available 
on the mail severs, which will do this 
automatically. You can confi gure Auto-
purging and other spam settings at

A

Q
A

A

A
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RSS: Get the News You Want 
When You Want It
• Robyn Fizz

hether you’re a news junkie or 
just want to stay on top of the 

latest developments in your fi eld, RSS 
can streamline your online browsing 
experience. RSS stands for Really Sim- 
ple Syndication (or Rich Site Summary). 
News reader software based on RSS 
displays current headlines from your 
favorite sources (e.g., The Boston Globe,
Wired News, releases from the MIT 
News Offi ce). Once you select a 
headline, you’ll generally see a short 
summary and a link to the full story.

You can subscribe to feeds from any 
publication that offers them, tailoring 
your choices along the way. The New 
York Times alone offers over 30 different 
feeds, ranging from Arts to Interna-
tional to Week in Review. Best of all, 
you can read your customized content 
at no charge. There are free news read- 
ers (also called news aggregators) for 
each platform, and there are no sub- 
scription fees for RSS feeds.

XML buttons at a given site, try typing 
“RSS” in the site’s search engine: it 
may take you to a page of feeds.

In order to subscribe to and read 
RSS feeds, you need news reader soft-
ware. While IS&T does not currently 
recommend or support any newsread-
ers, you can fi nd out more about RSS 
and available newsreaders at
http://web.mit.edu/ist/news/
rss-help.html

RSS is not as widely used as email 
or web browsing, but it’s likely to take 
off once it’s incorporated into popular 
web browsers. It’s due in the next re- 
lease of Apple’s Safari browser and is 
already built into Mozilla’s Firefox, 
which runs on Windows, Macintosh, 
and Linux machines.

Getting Started 
If you’d like some guidance before 

setting up a news reader, attend IS&T’s 
free RSS Quick Start. 
Sessions will be 
held on May 19 and 
June 16 at noon in 
the N42 Demo 
Center. ø

Not Just Your Standard News
While many people use RSS to tap 

into world or local news, there are 
many other types of RSS feeds. Adobe 
Systems, for example, offers a feed for 
each of its software applications. An 
Apple feed lists new releases from the 
iTunes Store. You can sign up for a 
daily Dilbert cartoon or keep track of 
your favorite web logs. If you follow 
an NPR feed to the full story, you can 
listen to an audio version – just as if 
you were listening to the radio. 

Closer to home, MIT’s Stellar course 
management system now offers a novel 
use of RSS: class web sites with feeds. 
Students who subscribe get the most 
recent announcements, class materi-
als, and assignments, plus alerts one 
week before an assignment’s due date. 
For other examples of MIT RSS feeds, 
including feeds from IS&T, see Surf 
Sites on page 8.

The Technology Score 
RSS is based on Extensible Markup 

Language (XML). If you’re visiting a 
web site and see a button – often 
orange – labeled “XML,” that button 
links to an RSS feed. If you don’t see 

W

Publish Dynamic Content on 
Your Web Site with RSS  
• Sean Brown

nformation Services and Technology 
(IS&T) has just launched a service 

that enables web publishers to include 
Really Simple Syndication (RSS) content 
in web pages hosted on web.mit.edu. 
It provides an easy way for MIT web 
publishers to add content to their pages 
that updates dynamically. The RSS 
Service works for both personal and 
organizational pages stored in Athena 
lockers.

From Static to Dynamic 
Most web pages at MIT are written  

in HTML, which is essentially a static 
format. Changing the content of a web 
page normally requires manual effort 
using a tool like Macromedia Dream-
weaver. When RSS is incorporated into 
HTML, web pages automatically dis- 
play content changes supplied by the 
news feed.

How the Service Works
The RSS service provided by IS&T 

is based on an open-source script called 
Feed2JS. The service provides a web 
form that lets you designate the news 
feed of your choice and confi gure var- 
ious display options. Submitting this 
form generates a small amount of 
HTML and JavaScript code that you 
place into the source code of your web 
pages. Once the code is added, any 
changes to the content of the RSS news 
feed will be refl ected within a few 
minutes on your web pages.

Using Cascading Style Sheets (CSS), 
you can customize the output of the 
RSS service so that it blends in with 
the existing look and feel of your web 
site. You can also set a number of feed 
options, including 
• The number of items to display

• Whether to display item descrip-
tions

• Length of item descriptions to 
show

Collaborative Efforts
IS&T’s Web Communications Ser- 

vices (WCS) and Operations and Infra- 
structure Services (OIS) Teams have 
collaborated on the rollout of the RSS 
service. The project has involved cus- 
tomizing the Feed2JS script, running 
a test pilot, and setting up a server to 
host the service. Sites currently using 
the RSS service include the School of 
Engineering and IS&T (see Surf Sites 
on page 8 for these URLs and others).

Learning More 
If you are interested in learning 

more about using RSS at MIT, attend 
a free IS&T Quick Start class on RSS. 
This presentation covers RSS basics 
and shows what’s involved in setting 
up the RSS service for your web site.  

Users of the RSS service are en- 
couraged to subscribe to a low-volume 
email list where new features regard-
ing the service will be announced. 
To join the list, send an email to 
<wcs-sysadmin@mit.edu>. ø
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Really Simple Syndication (RSS) is 
gaining momentum at MIT (see page 7 
for more on RSS). The sites to the right 
offer RSS feeds that you can subscribe 
to – with the exception of the School of 
Engineering site, which displays RSS 
feeds from other sources on its home 
page. These MIT-based RSS feeds pro- 
vide summaries ranging from head-
lines for Windows users, to major MIT 
campus and research news, to alerts 
about videos available at MIT World.

Most of the URLs on the right take 
you to summary pages that provide 
some background as well as links to 
the RSS feeds themselves.

Ed Tech Times: Educational Technology News @ MIT
http://edtech.mit.edu/times/

MIT Information Services and Technology
http://web.mit.edu/ist/news/rss-help.html

MIT News Offi ce
http://web.mit.edu/newsoffi ce/subscribe-rss.html

MIT School of Engineering (RSS-based content on home page)
http://web.mit.edu/engineering/

MIT World
http://mitworld.mit.edu/what_is_rss.php

Technology Review
http://www.technologyreview.com/newsfeed/aboutrss.asp

For help with… Dial… Or send a message to…

General computing questions 253-1101 computing-help@mit.edu
(Macintosh, Windows, and 
network/connectivity)
Academic computing 253-0115 f_l@mit.edu
Administrative applications 253-1101 computing-help@mit.edu
Athena Computing Environment 253-4435 olc@mit.edu
Computer and printer repairs 253-0815 pcservice@mit.edu
Computer presales consulting 253-7686 mcc@mit.edu
Disabilities and computing 253-7808 atic@mit.edu
Telephone and voice mail services 253-3670 telecom-csr@mit.edu
Telephone repairs 253-4357 3help@mit.edu
Unix/Linux 253-1103 unix-linux-help@mit.edu

If you don’t know where to get help 
for your computer, network, or 
telephone problems, dial one of the 
help lines listed to the right.

If you prefer to use email, you 
can send your questions to the cor-
responding email addresses on the 
far right. (When logged into Athena, 
you can also use the olc command 
to send questions to Athena’s online 
consultants.)

You can also submit a question 
online via Casetracker at 
http://casetracker.mit.edu/


